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Introduction

Welcome to Adobe InDesign! InDesign is a
comprehensive software program that
allows you to create output-ready layouts
for anything from a simple coupon to an
8-page newsletter to a 120-page full-color
magazine. What's even better is that, with
InDesign, Adobe Systems has created a lay-
out program that interfaces seamlessly
with Adobe Photoshop and Illustrator.

If you love those two applications, you'll
love InDesign too. In terms of its concept
and its intuitive design, InDesign is pure
Adobe. You'll feel right at home. In fact, at
times, you may need to remind yourself
that you're working in InDesign, not
Photoshop or Illustrator.
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The key word to keep in mind is layout:
That’s InDesign’s primary function.
Everything you need is here along with some
pleasant surprises. With InDesign, you can
build tables quickly and easily. You'll also
find that the table of contents and index fea-
tures are fun and easy to learn. And try to
remember that you're not using Illustrator
when you're positioning that text on a
curved path!

Best of all, you'll never have to leave the
world of Adobe. The interface of InDesign
with Photoshop and Illustrator allows
them to work together as something of a
trinity. From that combination, InDesign
emerges as one of the most powerful lay-
out utilities ever devised.
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In this lesson, you will start Adobe
InDesign and explore the workspace.
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EXPLORE THE

INDESIGN WORKSPACE

Looking at the InDesign
Workspace

The arrangement of windows and panels
that you see on your monitor is called the
workspace. The InDesign workspace fea-
tures the following areas: the document
window, the Application bar, the Tools
panel along the left side of the document
window, the pasteboard, panels along the
right side of the document window, and the

FIGURE 1

Essentials workspace Application bar
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status bar. Figure 1 shows the default
workspace, which is called Essentials.
InDesign CS4 offers a number of pre-
defined workspaces that are customized for
different types of tasks. Each workspace is
designed so that panels with similar func-
tions are grouped together.

For example, the Typography workspace
shows the many type- and typography-based
panels that are useful for working with type.
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You can switch from one workspace to
another by clicking Window on the applica-
tion bar, pointing to Workspace, and then

choosing a workspace or you can use the Object that

workspace switcher on the Application bar. ‘bleeds” onto
’ . the pasteboard

You can customize the workspace to suit on two sides

your working preferences; for example, you
can change the location of the Tools panel
and any of the other panels in relation to
each other. You can also save a custom work-
space by clicking Window on the Application
bar, pointing to Workspace, then clicking
New Workspace. Once the new workspace is
named, it will appear in the workspace menu.

Of all the four main workspace elements,
the role of the pasteboard is perhaps the
least obvious. The pasteboard is the area
surrounding the document. The pasteboard
provides space for extending objects past
the edge of the page (known as creating a
bleed), and it also provides space for storing
objects that you may or may not use in the
document. Objects that are positioned
wholly on the pasteboard, as shown in
Figure 2, do not print.

Exploring the Tools Panel

As its name implies, the Tools panel houses
all the tools that you will work with in
InDesign. The first thing that you should
note about the Tools panel is that not all
tools are visible; many are hidden. Look
closely and you will see that some tools have
small black triangles beside them. These tri-
angles indicate that other tools are hidden
behind them. To access hidden tools, point to

Lesson 1  Explore the InDesign Workspace

FIGURE 2
Using the pasteboard
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FIGURE 4
Three different setups for the Tools panel
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FIGURE 3

Hidden tools on the Tools panel

Small black
friangles
indicate
hidden tools

® X facangefnmeTon F ‘
® soutometos |
@ Poyentamatesy i

[@EE senuiunteo L@ Noe>~

The Ellipse tool
and Polygon
tool revealed
behind the
Rectangle tool

INDESIGN 1-5



the visible tool on the Tools panel, then
press and hold the mouse button; this will
reveal a menu of hidden tools. The small
black square to the left of a tool name in the
menu indicates the tool that is currently
visible on the Tools panel, as shown in
Figure 3. As shown in Figure 4, you can
view the Tools panel as a single column, a
double column or even as a horizontal row
of tools. Simply click the double arrows at
the top of the Tools panel to toggle between
the different setups.

Horizontal lines divide the Tools panel into
eight sections. The top section contains the
selection tools. The section beneath that
contains item creation tools—drawing tools,
shape tools, and type tools. Next is a section
that contains transform tools, such as the
Rotate tool and the Scale tool. You can think
of the next section as the navigation section,
which houses the Hand tool—used for
scrolling through the document—and the
Zoom tool—used for magnifying your view
of the document.

The bottommost sections of the Tools panel
contain functions for applying colors and
gradients to objects and choices for view-
ing modes used to display the page on your
screen. The Preview mode is probably used
most often since it allows you to view your
document without the guides being visible.

To choose a tool, simply click it; you can
also press a single key to access a tool. For
example, pressing [p] selects the Pen tool.
To learn the shortcut key for each tool,
point to a tool until a tooltip appears with
the tool’s name and its shortcut key in

INDESIGN 1-6

parentheses. Figure 5 shows the tooltip for
the Type tool.

CKIIP
Shortcut keys are not case-sensitive. In other wards, if you
press [p], you'll switch to the Pen tool regardless of whether
the Caps Lock key is pressed.

FIGURE 5
Viewing a tool name and shortcut key
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Working with Panels

Many InDesign functions are grouped into
panels. For example, the Paragraph panel
contains paragraph editing functions such
as text alignment and paragraph indents.
The Character panel, shown in Figure 6,
offers controls for changing the font, font
size, and leading. All panels can be
accessed from the Window menu. Some
panels are placed within categories on the
Window menu. For example, all of the text
and table-related panels, such as the
Character panel and the Table panel, are
listed in the Type & Tables category on
the Window menu.
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Paragraph panel ™~ |

Figure 7 shows three panels grouped
together. The Paragraph panel is the active
panel—it is in front of the others in the
group and available for use. To activate a
panel in a group, simply click its name tab.
Panels are collapsed along the right side of
the workspace. Clicking a panel name tab
opens the panel as well as the group of panels
that the panel is part of. The other panels in
the group appear as tabs. You can activate
other panels in the group by clicking the
appropriate panel name tab. Clicking the

active panel name tab closes the entire group.

When you choose a panel from the Window
menu instead of from the workspace, the
panel is displayed in its expanded view and it
includes a close button for closing the panel.

FIGURE 7
Three grouped panels

You can ungroup panels by dragging a
panel’s name tab away from the other pan-
els in the group. To add a panel to a group,
simply drag a panel by its name tab next to
another panel name tab.

QUICKTIP

You can restore the default arrangement of a given workspace
by clicking Window on the Application bar, pointing to
Workspace, then clicking the Reset command for that
workspace's name.

Don’t confuse grouping panels with docking
panels. Docking panels is a different function.
When you dock panels, you connect the bot-
tom edge of one panel to the top edge of

another panel, so that both move together.
To dock panels, first drag a panel’s name
tab to the bottom edge of another panel.
When the bottom edge of the other panel is
highlighted in bright blue, release the
mouse button and the two panels will be
docked. Figure 8 shows docked panels. To
undock a panel, simply drag it away from
its group.

QUICKTIP

You can temporarily hide all open panels and the Tools
panel simply by pressing [Tab]. Press [Tab] again to show
the panels and the Tools panel.

FIGURE 8
Docked panels
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FIGURE 9
Tools that contain hidden tools
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Responding to the Links dialog box

When you open a file, you may see a dialog box saying that this file contains links
to missing or modified files. If so, click Update Links. If necessary, do this whenever
this dialog box appears, with one exception: Chapter 6 is about linking support files,
and the Data Files have been provided with intentionally missing links.

Exploring the InDesign Workspac




FIGURE 10

Removing the Paragraph panel from the group
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FIGURE 11

Grouping the Character panel with the Paragraph panel
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Drag a panel

to the bottom
edge of another
to dock it
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FIGURE 12
Docking the Transform panel
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You explored the Tools panel, revealed hidden
tools, used shortcut keys to access tools quickly,
hid the panels, then displayed them again.

1. Click Paragraph on the right to open the
Paragraph panel.
The Paragraph panel is grouped with the
Paragraph Styles panel in the Typography
workspace.

2. Drag the Paragraph panel name tab to the
left so it is ungrouped, as shown in Figure 10.

3. Drag the Character panel name to the blank
space next to the Paragraph panel name tab,
then release the mouse.
The Character panel is grouped with the
Paragraph panel, as shown in Figure 11.

4. Click Window on the Application bar, point
to Object and Layout, then click Transform.

5. Drag the Transform panel name tab to the
bottom edge of the Character and Paragraph
panels group, then release the mouse when
they snap together.
The Transform panel is docked, as shown in
Figure 12.

6. Click the Transform panel name tab, then
drag it away from the other two panels.

The Transform panel is undocked.

7. Press [Tab] to hide all panels and the Tools
panel, then press [Tab] again to show them.

8. Click Window on the Application bar, point
to Workspace, then click Reset Typography.

You explored methods for grouping and ungroup-
ing panels, and you docked and undocked a panel.
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What You’ll Do

o
Dessert Menu

3
Dessert Menu

In this lesson, you will explore various
methods for changing the magnification
of your document.
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CHANGE

DOCUMENT VIEWS

Using the Zoom Tool

Imagine creating a layout on a traditional
pasteboard—not on your computer. For pre-
cise work, you would bring your nose closer
to the pasteboard so that you could better
see what you were doing. At other times, you
would hold the pasteboard away from you,
say at arms’ length, so that you could get a
larger perspective of the artwork. When
you're working in InDesign, the Zoom tool
performs these functions for you.

When you click the Zoom tool and move
the pointer over the document window, the
pointer becomes the Zoom pointer with a
plus sign; when you click the document
with the Zoom pointer, the document area
you clicked is enlarged. To reduce the view
of the document, press and hold [Alt] (Win)
or [option] (Mac). The plus sign changes to
a minus sign; when you click the document
with this Zoom pointer, the document size
is reduced.

Using the Zoom tool, you can reduce or
enlarge the view of the document from 5%
to 4000%. Note that the current magnifica-
tion level appears in the document tab and

in the Zoom Level text box on the
Application bar, as shown in Figure 13.

Accessing the Zoom Tool

As you work, you can expect to zoom in
and out of the document more times than
you can count. The most basic way of
accessing the Zoom tool is simply to click
its icon on the Tools panel, however this
can get very tiring if you have to access it
often. A better method for accessing the
Zoom tool is to use keyboard shortcuts.
When you are using any tool, for example
the Selection tool, don’t switch to the
Zoom tool. Instead, press and hold
[Ctrl][Spacebar] (Win) or [Spacebar]
(Mac). This keyboard combination changes
the Selection tool into the Zoom tool (in
the enlarge mode). Click the document to
enlarge the view; when you release the
keys, the Zoom tool changes back to the
Selection tool.

To access the Zoom tool in reduction mode,
press and hold [Ctrl][Alt][Spacebar] (Win)
or (] [option][Spacebar] (Mac).

Exploring the InDesign Workspace




QUICKTIP

Double-clicking the Zoom tool on the Tools panel changes
the document view to 100% (actual size).

In addition to the Zoom tool, InDesign
offers a number of other ways to zoom in
and out of your document. One of the
quickest and easiest is to press [Ctrl][+]
(Win) or [#][+] (Mac) to enlarge the view
and [Ctrl][-] (Win) or [%][-] (Mac) to reduce
the view.

You can also use the Zoom In and Zoom
Out commands on the View menu.

FIGURE 13
A reduced view of the document
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Using the Hand Tool

When you zoom in on a document—when
you make it appear larger—eventually the
document will be too large to fit in the win-
dow. Therefore, you will need to scroll to
see other areas of it. You can use the scroll
bars along the bottom and the right sides of
the document window. You can also use the
Hand tool to scroll through the document,
as shown in Figure 14.

The best way to understand the concept of
the Hand tool is to think of it as your own
hand. Imagine that you could put your hand

up to the document on your monitor, then
move the document left, right, up, or down,
like a paper on a table or against a wall. This
is analogous to how the Hand tool works.

QUICKTIP

Double-clicking the Hand tool on the Tools panel changes
the document view to fit the page (or the spread) in the
document window.

FIGURE 14
Scrolling through a document
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Chocolate Genoise cake
with a truffle center and
cocoa nutmeg glaze
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The Hand tool is often a better choice for
scrolling than the scroll bars. Why?
Because you can access the Hand tool
using a keyboard shortcut. Regardless of
whatever tool you are using, simply press
and hold [Spacebar] to access the Hand
tool. Release [Spacebar] to return to what-
ever tool you were using, without having to
choose it again.

QUICKTIP

When you are using the Type tool, don't use the [Spacebar]
shortcut to access the Hand tool because it will add spaces to
the text you are working with. Instead, use the scroll bar.

Creating Multiple Views of a
Document

You can create more than one view of a sin-
gle document using multiple windows. A
dual view is the most common—view the
document at 100% in one window, then
create another window to enlarge or
reduce the document. In this method of
working, you maintain a view of your docu-
ment at actual size (100%) at all times.

Click Window on the Application bar, point
to Arrange, then click New Window to cre-
ate a new window. To view both windows

INDESIGN 1-12

simultaneously, click Window on the
Application bar, point to Arrange, then click
Tile. The document in the new window will
have the number 2 in the document tab.
Figure 15 shows two tiled documents with
different magnification settings. You can
also use the new Arrange Documents menu
on the Application bar to manage and view
multiple document windows. The Arrange
Documents menu includes many options for
viewing multiple documents in a single win-
dow, such as 2-Up, 3-Up, 4-Up, and 5-Up.
You can choose to tile the windows verti-
cally or horizontally, or in a grid. This allows
you to move objects across documents.

FIGURE 15
Two views of the same document

Click the Float All in Windows command to
view each open document in a separate
floating window or the Consolidated
button to return all open documents to
tabbed documents.

QUICKTIP

(Macintosh) The commands for accessing the Zoom tool are
also the same shortcut commands for accessing Spotlight. For
the purposes of this chapter you should deactivate the Spatlight
feature by clicking the Apple icon on the Application bar, clicking
System Preferences, then clicking Spatlight. Remove the check
marks in the Spotlight menu keyboard shortcut and the Spotlight
window keyboard shortcut checkboxes.

by the number 2

Dessert Menu

Exploring the InDesign Workspace
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The Hand
tool becomes
a fist when
clicked and
dragged

FIGURE 16

Scrolling with the Hand tool
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Lesson 2 Change Document Views

3.

8.

Press [z] to access the Zoom tool A .

Position the Zoom tool over the document
window, click twice to enlarge the document,
press [AIt] (Win) or [option] (Mac), then
click twice to reduce the document.

Click the Zoom Level list arrow on the
Application bar, then click 800%.

Note that 800% is listed in the document tab.
Double-click 800% in the Zoom Level text

box, type 300, then press [Enter] (Win) or
[return] (Mac).

Click the Hand tool <7 on the Tools panel,
then click and drag the document window
so that the image in the window appears as
shown in Figure 16.

Double-click the Zoom tool A .

The magnification changes to 100%
(actual size).

Click the Selection tool X | point to the
center of the document window, then press
and hold [Ctrl][Spacebar] (Win) or
(#] [Spacebar] (Mac).
The Selection tool changes to the Zoom tool.
Click three times, then release [Ctrl}[Spacebar]
(Win) or (] [Spacebar] (Mac).

(continued)

INDESIGN 1-13



()

FIGURE 17
A reduced view of the document
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FIGURE 18
Two views of the same document

ID A-Lindd:2 @ 125% X |

—m

Dessert Menu

Dessert Menu

s » b @ Noerors » (8, 4 »

Lesson 2 Change Document Views

3. \Verify that the new window is the active window.

4. Press and hold [Ctrl][Spacebar] (Win) or
[Spacebar] (Mac), position the Zoom
pointer over the center of the new window,
then click twice.

5. Close the new window.

6. Click the Maximize button (Win) or the
Resize button (Mac) on the Application bar
to maximize the document window.

You created a new window and used the Zoom
tool to enlarge the view of the new document.
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What You’ll Do
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In this lesson, you will use various methods
for viewing individual pages and navigating
through a multiple page document.

INDESIGN 1-16

NAVIGAIE THROUGH

A DOCUMENT

Navigating to Pages in a
Document

When you are creating a layout for a mag-
azine, a book, or a brochure, by definition
you will create a document that has multi-
ple pages. Spreads are two pages that face
each other; a left page and a right page in
a multi-page document.

You have a variety of methods at your dis-
posal for navigating to pages or spreads in

FIGURE 19
Page buttons and the Page menu

your document. You can use the scroll
bars on the bottom and right sides of the
document window or choose a page from
the Page menu in the lower-left corner of
the document window. You can also use
the First Spread, Previous Spread, Next
Spread, and Last Spread buttons at the
bottom of the document window, as shown
in Figure 19. These navigation buttons
have corresponding menu commands on
the Layout menu.

1
2 Page menu
N 3
Y 5
First Spread &
button
Previous
Spread button
4 Next Spread button Last Spread button
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QUICKTIP
In multipage documents that do not have designated
left and right pages, the buttons are called First
Page, Previous Page, Next Page, and Last Page.

The Pages panel, shown in Figure 20, is a
comprehensive solution for moving from

page to page in your document. The Pages

panel shows icons for all of the pages in
the document. Double-clicking a single

Targeted page

FIGURE 20
Pages panel
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Lesson 3 Navigate Through a Document

page icon brings that page into view. The
icon representing the currently visible

page appears in blue on the panel.

Double-clicking the numbers under the

to display the Pages panel menu. This
menu contains a number of powerful

commands that you can use to control all

page icons representing a spread, as

shown in Figure 21, centers the spread in
the document window. In this case, both
icons representing the spread will appear
as blue on the Pages panel. Click the Pages

panel list arrow, also shown in Figure 21,

Pages panel list
arrow

QUICKTIP

Click the Panel Options command at the bottom of
the Pages panel menu to choose various display
options for the Pages panel.

FIGURE 21

A two-page spread selected on the Pages panel
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of your page navigation in InDesign.
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FIGURE 22
Page menu and the Page buttons
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1. Click the Page menu list arrow at the : —pT T e 3

bottom of the document window, then
click 3.

The document view changes to page 3.

2. Click View on the Application bar, then click
Fit Spread in Window.

3. Click the Next Spread button » .
Your screen should resemble Figure 22.
4. Click the Previous Spread button 4 twice.

5. Click Pages on the right to display the Pages
panel, (if necessary).
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TIP If you do not see the Pages panel

name tab on the right side of the document ' sscprinpui
window, click Window on the Application cream and igs

bar, then click Pages.

6. Double-click the page 6 icon on the
Pages panel.

The document view changes to page 6, and
the page 6 icon on the Pages panel changes to | Coiomm—y T
blue, as shown in Figure 23. /

Previous Pages menu  Next Spread
Spread button  listarrow  putton

(continued)

Creating custom workspaces

With InDesign CS4, you can customize the workspace as you like it—opening and
dragging panels wherever you want them—and wherever they help make your work-
flow the most efficient. When you are happy with the way that you have customized
your workspace, click Window on the Application bar, point to Workspace, then click
New Workspace. Assign a descriptive name to your workspace, verify that the Panel
Locations check box is checked, then click OK. To choose your workspace, click
Window on the Application bar, then point to Workspace. You'll see your custom-
named workspace in the list of workspaces.

INDESIGN 1-18 Exploring the InDesign Workspace



FIGURE 23 7. Double-click the page 3 icon on the
Targeting page 6 on the Pages panel Pages panel.

o PAGES 3 The right half of the spread—page 3—is
homel centered in the document window.

fitasered - 8. Double-click the numbers 2-3 beneath the
page 2 and page 3 icons on the Pages panel.

TP Double-clicking numbers below the

1
icons on the Pages panel centers the full
*; : spread in the document window.

2

« [m

9. Click Layout on the Application bar, then
&y e
e click First Page.
/@ You explored various methods for moving from one
gt a page to another. You chose a page from the Page
Targeted page menu, you clicked the Next Spread and Previous
Spread buttons, you selected page icons on the
Pages panel, and you used the Layout menu.
& Pages in 4 Spreads a 9

Pages panel options

To customize the Pages panel, click the Pages panel list arrow, then click Panel
Options to open the Panel Options dialog box. In the Pages and Masters sections of
the dialog box, you can choose a size for page and master icons by clicking the Size
list arrow, then clicking a size ranging from Extra Small to Extra Large. The Show
Vertically and Show Thumbnails check boxes in the Pages and Masters sections con-
trol how the icons on the panel are displayed. If you remove the Show Vertically
check mark, the page icons on the Pages panel will be displayed horizontally and you
will only be able to resize the width of the Pages panel, not the height. If you remove
the Show Thumbnails check mark, the page icons will be blank on the Pages panel.
Choosing not to show page thumbnails may free up computer memory. The Icons
section of the dialog box defines which additional icons appear next to the page icons.
For example, if the Transparency check box is checked, a small transparency icon
that looks like a checkerboard appears next to the page icon where transparency has
been applied to master items. Finally, in the Panel Layout section, you can choose
whether you want masters on top or document pages on top of the Pages panel.

Lesson 3 Navigate Through a Document INDESIGN 1-19




What You’ll Do
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In this lesson, you will access
InDesign help
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Accessing InDesign Help

Help! At some point we all need it. When
you do, you can use it to search for answers
to your questions using the InDesign Help
command on the Help menu.

InDesign Help opens in a new window
called InDesign Help and Support, with the
Community Help page open, as shown in
Figure 24. The Community Help page
includes the Getting Started section which
includes video tutorials, the Highlights sec-
tion which features special topics of interest,
the Troubleshooting section and the Top
Picks section. There are a number of ways to
learn more about InDesign using the

Community Page. You can also enter a key-
word in the Search text box at the top of the
window.

The Community Help Web site is a Help
system that offers searchable information
and instruction sources selected by Adobe
experts and Adobe users in the development
and design communities. The link for the
Adobe Community Help Web site is avail-
able on the home page of the Using Adobe
InDesign CS4 Web site. Clicking the link
opens the Adobe Community Help Web site.
There is a search text box at the top of the
page. Before you execute a search, you can
choose where you want your results from:

Opening InDesign CS4 files in InDesign CS3
InDesign CS3 cannot open InDesign CS4 documents. To open an InDesign CS4
document in InDesign CS3, you must export the CS4 document as the InDesign
Interchange (INX) format. Click File on the menu bar, click Export, then choose
InDesign Interchange from the Save as type menu. The exported document will be
. saved with the .inx file extension and can be opened in InDesign CS3. Note, however,
| that any new CS4 features applied to your document may be lost when the file is con-

t verted to the older format.
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Adobe.com, Support, or Community Help.
The Adobe.com link goes to a page on the
Adobe Systems Web site which lists articles
that may relate to your search, in the form
of hyperlinks. The Support link searches in
the Support Archives section of the Adobe
Systems Web site and the Community Help
link searches the entire Adobe community.

FIGURE 24
InDesign Help and Support page
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Using the Info panel
The Info Panel displays information about your document, selected object, or a current tool that you
may be using. The Info panel is for viewing purposes only. You are not able to enter or change any
information in the Info panel. The Info panel is used mostly to show position, size, or rotation,
however more information can be shown. If you click on the Info panel list arrow and click Show
Options, you can see other useful information such as names of swatches, document information (for
instance, author, date modified, file size), values for fill and stroke, as well as gradient information.

Lesson 4 Use InDesign Help

Using Adobe InDesign CS4
Help

You can also locate specific help by clicking
InDesign help (web) in the top right corner
of the window. This will open the Using
Adobe InDesign CS4 window, as shown in
Figure 25. The help information is organ-
ized by categories listed on the left side of
the window. Clicking the plus sign to the

Your page may differ T

to the Web site

Search text
box

Link to Using Adobe
Indesign CS4 page

left of a category displays all related topics
for that category. A plus sign to the left of a
topic name indicates that the topic
includes subtopics. Clicking a topic or a
subtopic displays the information in the
right pane. Adobe Help offers you the
power to do much broader searches and to
view a number of different topics at a
glance that relate to your search.

FIGURE 25
Adobe InDesign CS4 Home page
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Explore the InDesign workspace.
1. Start Adobe InDesign, then open ID 1-2.indd.

8. Drag the Layers panel name tab next to the
Pages panel name tab so that the two panels

8. Press and hold [Ctrl][Alt][Spacebar] (Win)
or [option][Spacebar] (Mac), then click

(Hint: You may see the Missing Fonts dialog
box which lets you know that one or more
fonts used in the document you are opening

panel, so that it is no longer docked.

INDESIGN 1-22

are grouped.

Change document views.

the mouse three times.

Navigate through a document.

S ol salnbi b Vol St Vou can 1. Click the Zoom tool, then click inside the 1. Click the Page menu list arrow, then click 3.
eirtier e tha substi)t/utl:: i ft:losén bu document window twice to enlarge the 2. Click View on the Application bar, then click
InDesian by clicking OK. or click Find Fyont document, press and hold [Alt] (Win) or Fit Spread in Window.
i ch%osganothe? font, ol ok e inio b th [option] (Mac), then click twice to reduce 3. Click the Previous Spread button.
Bt Eort diio by Aler i¥ i a5 s the document. 4. Click the Next Spread button two times.
9. bl ! : 9 2. Click the Zoom Level menu list arrow, then 5. Inthe Pages panel, double-click the
box about modified links, click Update Links.) : ;
2. Point to the Type tool, and press and hold 0. PAge 8 rcah,
2 LT bu);tpon unt}| oupsee the hidden 3. Double-click 600% in the Zoom Level text 6. Double-click the numbers 2-3 beneath the
st bangath b y box, type 800, then press [Enter] (Win) or page 2 and page 3 icons on the Pages panel.
8. Usirathe sam'e UROH vl hidder [return] (Mac). 7. Click Layout on the Application bar, then
’ toolsgbehin JAhe otfiar t(;ols & il 4. Double-click the Zoom tool on the Tools panel. click First Page.
Bigek Sinates 5. Click the Selection tool, position it over the
: : e o : center of the document window, then press
4. Click Window on the Application bar, point :
; and hold [Ctrl][Spacebar] (Win) or
to Workspace, then click [Typography]. [Spacebar] (Mac)
5. Drag the Pages panel away from its group ; :
; ! 6. Click the mouse once, then release
on the right side of the workspace to the :
; [Ctrl][Spacebar] (Win) or
center of the document window. [S acebar] (Mac)
6. Drag the Layers panel away from its group, p :
g 7. Press [Spacebar] to access the Hand tool,
then dock it beneath the Pages panel.
then scroll around the document.
7. Drag the Layers panel away from the Pages
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SKILLS REVIEW

(CONTINUED)

8. Compare your screen to Figure 26, then close
ID 1-2.indd without saving any changes.

Exploring the InDesign Workspace

FIGURE 26
Skills Review

o the hillside sits
mountainside
like a soft blanket 'M“df.“mm
their meeting leaves behind
A oo Fown Bt only the black sand

as with all true beauty the water moves
the flowers require no flattery and rolls and crashes
they are confident the trees listen
in their grace and observe
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